VIRTUAL WHITEBOARD

PEN ................................................................................................................................. 1
  Calibrating ....................................................................................................................... 2
IPM Selections .................................................................................................................... 2
Launching Virtual Whiteboard ............................................................................................ 2
Changing the Background .................................................................................................. 3
Inserting BITMAP Images Using Snapshot ......................................................................... 5
Printing Your Notes .......................................................................................................... 5
Set Print Quality .................................................................................................................. 6
Enable or Disable ................................................................................................................. 6
Background ........................................................................................................................ 6
Viewing your Entire Session and Exporting Notes ............................................................... 6
Why Export Notes? ............................................................................................................. 7
  How to Export your notes ................................................................................................ 7
Placing the VWB pages into a Word Document ................................................................... 9
How to Save a File ............................................................................................................... 9
Pack & Go in Virtual Whiteboard .......................................................................................... 10
Dockable Toolbar ................................................................................................................ 10
USING PRESENTATION TOOLS ....................................................................................... 12
Using the Help Function ..................................................................................................... 13
Snapshot ............................................................................................................................. 14
  Using Snapshot ............................................................................................................... 14
  Where Snapshot Goes .................................................................................................... 15
Slideshow .......................................................................................................................... 17
  Different Views ............................................................................................................... 20
VIRTUAL WHITEBOARD

The Interactive Presentation Manager (IPM) – Whiteboard is a digital, electronic board that connects to a PC and LCD projector allowing you to control software, capture/re-use information for many purposes, and print/save/email screens/files as needed.

PEN

The pen is used like a mouse for this product. This pen has 2 parts – the pen tip and the red side button. Depressing the pen tip will give you a left mouse click, allowing you to write on the board or select a Softkey. Depressing the pen tip twice quickly equals a double left mouse click. The red button on the side of the pen equals a right mouse click. Like a desktop mouse, you may not press the right and left mouse buttons at the same time, therefore, press the pen tip or the red side button, NOT both at the same time.
Please note: If your pen has remained idle for an extended period of time, it goes into “sleep mode” to save the pen charge. To activate the pen again, simply tap the screen with the pen tip.

Calibrating
the Pen is important. This will align the computer image with the board so that your writing will appear where you want it to go. Here are step-by-step instructions and illustrations on how to calibrate the board.

1. Select the <Calibrate> Softkey with a left mouse click.
2. Left click <Calibrate> on the screen
3. Follow the onscreen instructions.

In four (4) clicks you will have pinpoint precision at a resolution of 1,000 lines per inch.

IPM Selections
IPM Selections allows for quick and easy access to the different applications and help functions of IPM. To open IPM Selections, press the <?> Softkey, as seen on Page 1. The following dialog box will appear:

Launching Virtual Whiteboard
Now that the Pen has been calibrated, the Whiteboard can be launched. The Whiteboard Softkey is located directly above the Calibrate Softkey (bottom Softkey). The icon is a picture of a notepad. See page 1.

When the Whiteboard has been launched, the default background color is white and the default pen color is black. You can write and erase information similar to a regular dry-erase board. However, this electronic Whiteboard has many more amazing features. The Preset Background below is just one of the many backgrounds available.
Changing the Background

The Present Backgrounds include: Default (white background), Blackboard, Graph Paper, Ruled Yellow Pad, Blackboard With Graph, Greenboard, Greenboard With Graph, Precision Graph Paper, Ruled White Pad, Ruled Blackboard, Ruled Greenboard, Music Sheet, and Cursive (D’Nealean).

To change the default background take the following steps:

1. Click on <Format> from the menu bar, then <Options>. The Session Properties dialog box will appear.
2. Under the <Page> tab, left click the down arrow under <Presets>
3. Left click on the background of your choosing (on this screen precision graph paper has been selected).
4. Select <OK>

The new background will take effect on the “current” page.
The Basic Tools

The toolbar contains the options of the VWB. Think about where the uses of color and/or shapes really help individuals to see differences or connections more clearly. And remember, you can save the notes and reuse them for a later time. Or, you may print them for someone who was absent or for a person who needs assistance with note taking. Listed below are a few of the features available on the Toolbar:

- Tools are selected when you left click on one of the tool icons. (You will know which tool is active because it will be indented.
- Colors are selected by left clicking on one of the color icons.
- You may also access the tools and colors through <Tools> on the Menu bar.
- You may select additional colors beyond the default pen colors of black, red, green and blue by left clicking the multicolored icon and select the color of your choice (or choose define Custom Colors) and select <OK>.
- There is an advance or go back a page icon to be used with a left click.
- Undo or redo icons.
- The Text Tool is used for typing information on the Whiteboard. Select the Virtual Keyboard Softkey #14 and use the left mouse click (Pen tip) to select your letters from the Virtual Keyboard. Your text will automatically appear in the text box. You can change font, size, etc. of your text or move an image with the Select Object Tool.

- You can rearrange or manipulate your annotations and drawings by selecting an area you wish to move (with the Select Area tool) and then cutting/coping and pasting the selected area to the current page or new page.

This is the Select Area Tool.
Inserting BITMAP Images Using Snapshot

You may insert BITMAP images into a VWB page and continue with your annotations or drawings as normal. This feature can be very helpful when you want to write notations on a picture or an Internet web page. For example, in a Science class, you may have a picture of a dissected frog. You may insert the picture into a VWB page and then label the parts of the frog with the VWB annotation pens. The benefit is that all the information will automatically be saved.

1. First, you must take a Snapshot of a weather map
2. From the menu bar, select <Insert> Then <Bitmap>
3. Insert the slide of choice, move it to your desired location and annotate as usual

Printing Your Notes

You can print the current (or opened) VWB page by using the shortcut key located on the menu bar. The printer icon. Or you can select <File>, then <Print> for the current page, or <Print All> for the entire session.
Because you may have a selected a colored background (discussed on page 3), you may wish to disable background printing on occasion when printing. This will save the printer ink. Click Format on the Menu Bar>Select Options>Print Tab

Viewing your Entire Session and Exporting Notes

You can navigate through the pages of your VWB session using the Advance and Go Back buttons. When you have many pages and want a more efficient way to jump from page to page or to export your pages as a different file, use the Thumbnail Viewer. The Thumbnail Viewer shows all the pages in the session so you may quickly toggle back and forth between pages.

How to open the Thumbnail Viewer:

- Under <View> select <Thumbnail Viewer> OR use the shortcut option on the toolbar located to the right of the printer.
How to jump to a page using the Thumbnail Viewer:
- Left click on the little window above the page number of desired page.

How to select a page for printing, copying, or exporting notes:
- **Right click** (hold the pen close to the board and depress the red side button) over the minimized page area to select the page. The page number will highlight red.

**Why Export Notes?**
If you want to e-mail notes to an absent student or a colleague, you can accomplish this with <Export Pages>. The notes can be saved in 9 different file formats such as JPEG, BITMAP and TIFF. Saving the notes in a different file format allows the receiver to open the VWB notes even if they do not have the VWB software on their computer. By saving a page as a JPEG, you are saving a picture of your notes. You should give the session a name such as “Civil War Notes” and then attach as a file when you e-mail.

**How to Export your notes:**
1. Open the Thumbnail Viewer
2. Select individual pages by right clicking as described above or left click on <Select All>
3. Under <File> in the Thumbnail Viewer, select <Export Page(s)>

This is where you rename the session so it is easier to locate later. The VWB files are stored in the Sessions folder. These files may be opened when you are in VWB by selecting <Open>. Also, when you e-mail notes, this is where you will go to locate the files for attachment.
Placing the VWB pages into a Word Document

If you want to insert VWB pages in a Word document to create a handout, test or quiz or to just add text around your notes, there are two methods to choose from:

Method 1:

1. Select <Edit> from the menu bar.
2. Choose <Copy Current>. Your notes are now saved to the clipboard. Please note that only the displayed page of the session has been copied.
3. Open a new document in Microsoft Word
4. Select <Edit> from the menu bar and choose <Paste>

(This same copy and paste techniques can be used through the Thumbnail Viewer if this is more efficient for you.)

Method 2:

1. Select the area you want to copy with the Select Area tool.
2. Once you have selected your desired area, left click on the Copy or Cut icon. Your selected area will be copied to the Microsoft Clipboard.
3. Open a new document in Microsoft Word
4. Select <Edit> from the menu bar and choose <Paste> or simply left click on the Paste icon.

How to Save a File

All sessions are automatically saved as a “date-stamped file” in the Sessions folder on your computer’s hard drive. However, saving your work as a specific name will be helpful in using the notes for another class or later in the year. To save your work under a new name, follow these steps:

1. Select <File> from the menu bar.
2. Under <File> select <Save As>

Notice that each time you use the board, the session is automatically saved by the date. Each new sessions created that day, is then numbered as well. You can choose where to save the session by left clicking on the drop-down arrow by <Save In> (C:/ drive, floppy disc, etc).

Note: the file is saved as a Whiteboard file (.vwb). In order to open VWB notes on a computer that does not have IPM software or a VWB viewer, you will need to either (1) Export the notes as a picture (2) Cut and Paste the notes into another application or (3) Use Pack & Go.
Pack & Go in Virtual Whiteboard

Pack and Go allows a Virtual Whiteboard session to be compressed and saved into a single file for exporting to other computers. A Pack and Go file is an executable file that can be emailed or burned onto a CD Rom and does not require the Virtual Whiteboard application at the remote end in order to view. If the receiving computer does not have the VWB application installed, the VWB viewer is necessary. Click File on the File Menu>Pack and Go

Pack and Go files are saved in My Computer> C:/ Drive> Program Files> Interactive Presentation Manager> Pack and Go. This is where you will go to locate a file to attach to an email. To open a Pack and Go file that was sent via email, simply double click on the file. The file is self-extracting.

To view the self-extracted VWB file, you will need to have the VWB application (this is installed on a computer when the IPM software is loaded on a computer) or the VWB Viewer installed on your computer. The VWB Viewer may be attached to the email along with the Pack and Go file. (The VWB Viewer is found at My Computer> C:/ Drive> Program Files> Interactive Presentation Manager> VWB Viewer). Or you may download the VWB Viewer application from the Numonics website Driver page under the Interactive Presentation Manager heading at: http://www.numonics.com/support/drivers.htm. The VWB Viewer is an executable file that will automatically install on a computer once it is opened.

Dockable Toolbar

You can relocate the VWB toolbar from the top of the screen to the bottom. Shorter people will benefit from the dockable toolbar. Simply grab the toolbar using the left mouse click on the pen and drag it to the bottom of the screen. When you pick the pen off the board, the toolbar will snap to the bottom of the board. You can move it back to the top using the same procedure in reverse.
The Softkeys

The Softkeys software and the VWB software are two separate software applications. The Annotation Pen, Highlighter, and Eraser Presentation Tools will not work while you are in VWB. You do not need to remember this though because if you try to use these Presentation Tools you will hear a sound from your computer to remind you the Tools are unavailable. Try to use the Softkey pens in VWB and listen for the sound. The reason the Softkey Annotation Pens do not work is because you already have these annotation tools in VWB.

The other Presentation Tools such as Zoom, Reveal, Spotlight, Subliminal Message and Timer will work in VWB and can really aid a presentation. So what are the Factory default Softkeys?

**DEFAULT SOFTKEYS**

1: Next
2: Previous
3: End show
4: Annotation Pen - Red
5: Annotation Pen - Black
6: Highlighter
7: Rubberstamp
8: Eraser
9: Clear screen
10: Reveal
11: Spotlight
12: Zoom
13: Applause
14: Virtual keyboard
15: Snapshot
16: Unassigned
17: Unassigned
18: IPM Selections
19: Launch VWB
20: Calibrate IPM
USING PRESENTATION TOOLS
Here are some examples of how your product will appear after selecting some of the Softkeys linked to presentation tools.

The **Virtual Keyboard** can be used to type in information instead of having to walk back to the computer in the room. The example here shows using the keyboard in Excel.

The **highlighter** can be used to call attention to detail.
Using the Help Function

Now that you can see a few of the possibilities of the Presentation Tools, read about the rest of the features in IPM Online Help. Select the IPM Selections <?> Softkey and then choose the IPM Online Help button.

The Clear Screen Softkey deletes any annotations on the screen.

Reading under Presentation Tools is a detailed explanation of this software.
Snapshot

If you annotate in any software program such as PowerPoint or even the Internet and want to save notes to recall or to print later, use the Snapshot feature. Follow these steps to take a Snapshot (or picture) of your annotations.

Note: Presentation Tools must be defined to retain annotations in order for your annotations to be saved with the Snapshot feature.

Using Snapshot

Note: The Default setting for Snapshot will capture the entire screen. In this exercise, we will be taking a snapshot of just a portion of the screen.

1. First, redefine the Snapshot Softkey using the Softkey Editor so that you can select just the area of the screen you want to save. Otherwise, the snapshot will take the entire visible portion of the screen that you can see on the board.
2. Annotate over your Internet page.
3. Select the <Snapshot> Softkey. Put the pen to the board, you will notice a square of dashed lines appear on your screen. Using the pen, place the square starting in the upper left of where you want it and drag to the bottom right. You must keep contact with the board at all times! When you release the pen from the board, a snapshot will be taken of the area you just selected.
Where Snapshot Goes

(NOTE: THESE PATHS WILL BE THE SAME ON YOUR COMPUTER UNLESS YOU CHANGE THEM)

To insert your snapshot into a document, or to locate it to rename, follow the steps below:

1. Double left click on <my computer>

2. Next, select the <C-drive> (hard drive) by double left clicking.

3. Once the C-drive is open, it will appear something like this:
   Select <Program files> with a double left click.
4. Inside Program files select the **<Interactive Presentation Manager>** folder with a double left click.

![Program Files]

**Warning**

Modifying the contents of this folder may cause your programs to stop working correctly.

To add or remove programs, click Start, point to Settings, click Control Panel, and then click **Add/Remove Programs**.

Select an item to view its description.

5. Once inside this folder you will see many folders: **Backgrounds** (from VWB), **INI, Pack and Go** (from VWB’s Pack and Go), **Sessions** (from VWB), **Slides** (from Snapshot), **Softkeys** (from different saved Softkey sets), **Temp**, **Tutorial**, and **VWB Viewer** (where the VWB Viewer is located). To access your snapshots, double left click on the **<Slides>** folder. To open the other folders you would double left click on the appropriate folder.
6. Notice each slide is dated. You can open any slide by double left clicking. Just like it is a good idea to rename your VWB files, you should give your slides a file name so it is easier to insert later. In addition to renaming VWB sessions/files, it may be beneficial to create folders to organize the sessions. You should create new folders and file names for all your VWB sessions and Snapshots to help make it easier to locate them at a later date.

![Slides](image)

7. Snapshots are saved as Bitmap (.bmp) files. To insert a Snapshot into a PowerPoint, or Word document, you would select <Insert> from the menu and then <Picture>, <From File> because a Snapshot is a saved picture.

**Slideshow**

The SlideShow is an application that will allow you to create and arrange a slide show made of Virtual Whiteboard screens (.vwb) or Bitmap files (.bmp) such as those made by the Snapshot tool. This application is useful when you want to arrange and organize pages from a VWB session with Snapshot images and/or other Bitmap files.

1. To open SlideShow, launch IPM Selections (the <?> Softkey) and select SlideShow,
2. The following screen will appear:

![IPM Slide Show interface]

1. Begin your slideshow by inserting a NEW SLIDE.
2. A dialog box will appear. To Insert a VWB session, browse your hard drive for the IPM Sessions folder to locate the VWB session you want to insert.

3. This dialog box will appear to display all the VWB pages of your selected session. To INSERT a page, Right Click over the thumbnail of the page you want. (The page # will highlight red). Click the “I” icon. Your pages will then be inserted into SlideShow.

3. If you wish to OPEN an existing SlideShow, simply click on <File>, then <Open>.
Different Views

4. SlideShow has several different View Options:
   (a) Individual slides or
   (b) run the whole show like a PowerPoint presentation

Selecting <Slide Show> from <View> allows you to run the presentation from beginning to end. You advance slides by hitting Softkey #1 (Next) or return to previous slides by selecting Softkey #2 (Previous). To end the show, simply select Softkey #3 (End Show) just like in PowerPoint.

In any of the three views you may use annotation pens and other Presentation Tools but remember to select Snapshot to save any of your annotations on top of existing slides.

5. You can add or duplicate slides easily under the Insert menu. Inserting a slide puts it at the end of the show. You may drag & drop that slide anywhere in the presentation thereafter. To duplicate a slide, first identify a slide by clicking on it. A thin blue border identifies the slide. Then select <Insert> and <Duplicate Slide> and it will duplicate and place the slide at the end of the presentation. You can re-position the duplicate anywhere in the slide show by dragging and dropping as before.
6. Under the Slide Show toolbar, you can Run a show or you can Hide a slide. <Run Show> will start the Presentation and <Hide Slide> will hide the selected slide during the Presentation.

NOTE: To hide a slide, you must first select the slide by clicking on the desired slide. A thin blue line will identify that slide. Then, select <Hide Slide> under Slide Show and the slide will be hidden when running your presentation.

You will know which slides are hidden as the number beneath the slide will have a line through it in the middle of the number. To Unhide, select the slide again, and go to the Slide Show menu and the Hide Slide will now show as Unhide Slide. Selecting <Unhide Slide>, you restore the slide to its original state.

7. You may delete a slide by identifying the slide with a left mouse click over the thumbnail, clicking <Edit> from the toolbar and the choosing <Delete Slide>. That will permanently remove the slide from the slide show.